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About This Guide 
This guide describes the process for setting up your IBM® TRIRIGA® Application Platform environment 
to work with SAP Crystal Reports. For more information about installation, go to the IBM TRIRIGA 
Application Platform 3 Knowledge Center and select Installing IBM TRIRIGA Application Platform. For 
more general information about reports, see the IBM TRIRIGA Application Platform 3 Reporting User 
Guide. 

Conventions 
This document uses the following conventions to ensure that it is as easy to read and understand as 
possible:  

 Note – A Note provides important information that you should know in addition to the 
standard details. Often, notes are used to make you aware of the results of actions. 

 

 Tip – A Tip adds insightful information that may help you use the system better. 

 

 Attention – An Attention notice indicates the possibility of damage to a program, device, 
system, or data. 

Intended Audience 
This guide is for users of IBM TRIRIGA Application Platform who develop or maintain SAP Crystal 
Reports. 

Prerequisites 
This guide assumes the reader has a basic understanding of the IBM TRIRIGA Application Platform. 

To use SAP Crystal Reports with the IBM TRIRIGA application, you must purchase and install the correct 
version.  

Support 
IBM Software Support provides assistance with product defects, answering FAQs, and performing 
rediscovery. View the IBM Software Support site at www.ibm.com/support. 

http://www.ibm.com/support
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1. Overview 
IBM TRIRIGA can run reports using an external report generator named SAP Crystal Reports. SAP Crystal 
Reports is a popular report generator used by many organizations. SAP Crystal Reports offers the ability 
to generate many kinds of reports that are not possible using the IBM TRIRIGA Report Manager. SAP 
Crystal Reports also offers many formatting possibilities that are not available with the IBM TRIRIGA 
Report Manager. 

Why use SAP Crystal Reports? 

 Popular reporting tool and market leader in reporting technology 

 Quick and rapid report development 

 Integrates well with many applications 

 Connects to most databases available in the market, including XML (eXtensible Markup Language) 

 Has robust formatting capability  

 Allows exporting to a variety of popular formats 

Server configuration 

SAP Crystal Reports runs on a server computer. It can be running on the same server as the platform or 
on a separate server.  

The Tools Server runs the SAP Crystal Reports Server (RAS) engine. It communicates with the 
Application Server and the Process Server via TCP/IP and with the Database Server via JDBC. The Tools 
Server does not communicate directly with users and is kept isolated from HTTP requests. 

The SAP Crystal Reports Application Server (RAS) is used to run SAP Crystal Reports from the IBM 
TRIRIGA Application Platform. 

For additional information about the hardware configuration of the IBM TRIRIGA Application Platform, 
go to the IBM TRIRIGA Application Platform 3 Knowledge Center and select Installing IBM TRIRIGA 
Application Platform. 

URL providers 

For WebSphere configuration, you will need the Name, JNDI name, and Specification to enter as URL 
providers. Instead of {config_path}, use the actual path to the config directory of the IBM TRIRIGA 
installation, for example C:/Tririga. 

Name TRIRIGACRYSTAL 

JNDI name url/TRIRIGAProperties/TRIRIGACRYSTAL 

Specification file:/ {config_path}/config/TRIRIGACRYSTAL.properties 
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2. Installing and configuring 
IBM TRIRIGA provides integration with SAP Crystal Reports by allowing reports created using the SAP 
Crystal Report designer to be accessed directly from within IBM TRIRIGA applications. 

This integration involves the IBM TRIRIGA Application Server and the SAP Crystal Reports Application 
Server and includes several phases: 

 Configure TRIRIGACRYSTAL.properties 

 Install the SAP Crystal Report Viewer files 

 Install SAP BusinessObjects Enterprise XI and configure the SAP Crystal Reports Server 

 Optionally, enable Crystal support on WebSphere 8. 

Configure TRIRIGACRYSTAL.properties 

Locate your copy of the TRIRIGACRYSTAL.properties file. Look in the config folder in your IBM 
TRIRIGA installation folder. A typical path is C:\Tririga\config\TRIRIGACRYSTAL.properties. 

Step  

1. Edit 
TRIRIGACRYSTAL.p
roperties.  

2. Review the 
information in the 
comments at the top 
of the file.  

3. Change any values as 
appropriate for your 
installation. 
Additional 
information can be 
found in the 
TRIRIGACRYSTAL.p
roperties section. 

4. Save your changes to 
TRIRIGACRYSTAL.p
roperties. 
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Install SAP Crystal Report Viewer files 

You must install the SAP Crystal Reports 2013 .jar files and the SAP Crystal Report Viewer files. 

 NOTE: If your IBM TRIRIGA server is running on a UNIX operating system, the file names are case 
sensitive. Make sure that the name and case of the JAR files and Viewer files that are downloaded 
match the names shown in the steps. 

Step 

1. Select and copy jar files on your Crystal server. 

For Linux Crystal Server, select the jar files below from the 
DirectoryWhereCrystalServerIsInstalled\sap_bobj\enterprise_xi40\java\l
ib directory. 
 
For Windows Crystal Server, select the jar files below from the 
DirectoryWhereCrystalServerIsInstalled\SAP BusinessObjects\ SAP 
BusinessObjects XI 4.0\java\lib directory.  
 
CrystalReportsSDK.jar 
logging.jar 
webreporting.jar 
webreporting-jsf.jar 
sap.com˜tc˜sec˜csi.jar 
 
Copy the files to the 
DirectoryWhereTRIRIGAInstalled\userfiles\crystalreports\reports\Crysta
lSdkRasClassLoader directory.  Create any directories that are not yet created. 
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Step 

2. Select the following directories and files in the 
DirectoryWhereCrystalReportsIsInstalled\SAP BusinessObjects\ SAP 
BusinessObjects Enterprise XI 4.0\java\lib directory: 

Directories: 
ActiveXControls 
css 
html 
images 
js 
prompting 
urlreporting 
 
Files: 
allInOne.js 
allStrings_en.js 
api-min.js 
crsmarttag.jsp 
parameterUIController-compressed.js 
preview.jsp 
processindicator.js 
promptengine-compressed.js 
ViewSeed.js 

 

And copy the selected directories and files to the 
DirectoryWhereTRIRIGAInstalled\userfiles\crystalreports directory. 

3. Click http://downloads.businessobjects.com/akdlm/crystalreportsforeclipse/2_0/crjava-
runtime_12.2.217.zip to download a zip file containing the Crystal SDK runtime libraries. The 
downloaded zip file is named crjava-runtime_12.2.217.zip. You can also access the zip file by 
clicking http://www.sap.com/solution/sme/software/analytics/crystal-reports-
eclipse/index.html, submitting your SAP credentials, and clicking the Runtime libraries at the 
bottom of the page. 

 

http://downloads.businessobjects.com/akdlm/crystalreportsforeclipse/2_0/crjava-runtime_12.2.217.zip
http://downloads.businessobjects.com/akdlm/crystalreportsforeclipse/2_0/crjava-runtime_12.2.217.zip
http://www.sap.com/solution/sme/software/analytics/crystal-reports-eclipse/index.html
http://www.sap.com/solution/sme/software/analytics/crystal-reports-eclipse/index.html
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Step 

4. In the lib directory located at the root of the .zip file, select the following .jar files:  

com.azalea.ufl.barcode.1.0.jar 
commons-configuration-1.2.jar 
CrystalCommon2.jar 
CrystalReportsRuntime.jar 
cvom.jar 
DatabaseConnectors.jar 
icu4j.jar 
jai_imageio.jar 
JDBInterface.jar 
jrcerom.jar 
keycodeDecoder.jar 
logging.jar 
pfjgraphics.jar 
QueryBuilder.jar 
webreporting.jar 
webreporting-jsf.jar 
xpp3.jar 
 

And copy them to the 
DirectoryWhereTRIRIGAInstalled\userfiles\crystalreports\reports\Crysta
lSdkEmbeddedClassLoader directory. 

5. From the crystalreportviewers directory found at the root of the ZIP, select the 
following files and directories: 

Directories: 
ActiveXControls 
css 
html 
images 
js 
prompting 
 
Files: 
allInOne.js 
allStrings_en.js 
processindicator.js 

 

And copy them to the 
DirectoryWhereTRIRIGAInstalled\userfiles\crystalreports\jrc directory. 
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Step 

6. Locate the following JAR files, which are part of Apache Xalan version 2.7.1, in a ZIP file that 
can be downloaded from the following location: 
http://www.apache.org/dyn/closer.cgi/xml/xalan-j 
 
On this site, choose a mirrored site from which to download the ZIP file. Select the link titled 
XML/Xalan java archive. Select the download link labeled xalan-j_2_7_1-bin.zip. 
The JAR files can be found in a directory named xalan-j_2_7_1 at the root of the ZIP file. 
 
serializer.jar 
xalan.jar 
xerceslmpl.jar 
 
Place these JAR files in the following location: 
DirectoryWhereTRIRIGAInstalled\userfiles\crystalreports\reports\Crysta
lSdkEmbeddedClassLoader 

7. Restart the IBM TRIRIGA application server. 

 

Install SAP BusinessObjects Enterprise XI 4.0 (BOE) / 
Crystal Server 2013 
There are two steps: 

1. Install SAP BusinessObjects Enterprise XI 4.0 (BOE).  
 
As of IBM TRIRIGA Application Platform 3.2, IBM TRIRIGA no longer provides the Crystal BOE 
installer. Customers can use what they already have or can contact SAP to get access to the 
Crystal BOE installer. New customers or customers that do not already have Crystal or BOE 
licenses must use BIRT unless they acquire their own Crystal or BOE license. 

 
2. Configure the SAP Crystal Report Server. 
 
 

Configure the SAP Crystal Report Server.  

The configuration of the SAP Crystal Report Server depends on whether you are using Windows or 
Linux. This section first describes the configuration for Windows, then for Linux. 

 

Configure the SAP Crystal Report Server on Windows 

The IBM TRIRIGA Java data source must reside on the SAP Crystal Report Server. If it does not, many 
reports will fail to run and will display a message similar to the following error: 

http://www.apache.org/dyn/closer.cgi/xml/xalan-j
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Could not open Report Client Document. Caused by: 
com.crystaldecisions.sdk.occa.report.lib.ReportSDKServerException: 
Failed to open the connection. 

To configure the SAP Crystal Report Server, make the following changes: 

Step  

1. Navigate to the /tools/Crystal folder in the IBM TRIRIGA installation folder. 

For example: C:\Tririga\tools\Crystal 

2. Copy rowset.jar and TririgaCrystalClient.jar and paste them into 
DirectoryWhereCrystalReportServerInstalled\SAP BusinessObjects\SAP 
BusinessObjects Enterprise XI 4.0\dataAccess\connectionServer\java 
folder. 

 

3. On the SAP Crystal Reports Server, navigate to the SAP Crystal Reports installation directory, 
then to the \common\4.0\java folder. 

For example: C:\Program Files\Business Objects\common\4.0\java. 

4. Edit CRConfig.xml to include TririgaCrystalClient.jar and rowset.jar in the 
JavaBeansClassPath, as shown in the following example. Replace {install_path} with your 
actual BusinessObjects Enterprise install path. 

<JavaBeans> 
  <CacheRowSetSize>100</CacheRowSetSize> 
  <JavaBeansClassPath> 
 {install_path}\SAP BusinessObjects\SAP BusinessObjects Enterprise XI 
4.0\dataAccess\connectionServer\java\TririgaCrystalClient.jar; 
{install_path}\SAP BusinessObjects\SAP BusinessObjects Enterprise XI 
4.0\dataAccess\connectionServer\java\rowset.jar 
 </JavaBeansClassPath> 
  <CallBackFunction>CrystalReportsLogoff</CallBackFunction> 
</JavaBeans> 
 

 NOTE: Make sure the text starting with <JavaBeansClassPath> and ending with 
</JavaBeansClassPath> is on one line. 

5. Start the Central Management Console. The default URL is 
http://localhost:8080/BOE/CMC. The User Name is Administrator and the Password 
is what you set during installation. 
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Step  

6. Navigate to Servers -> 
Servers List -> Report 
Application Server. 

 TIP: The Report 
Application Server is on 
the second page of 
servers. 

7. Right click and stop 
the server.   

8. Right click and select 
Properties. 

 

In Command Line Parameters, 

9. Specify the “-ipport 
<port #>” for the 
server. Add it to the 
end of the Command 
Line Parameters. 

The default port is 1566. 
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Step  

In Common Settings, 

10. In Request Port, 
select the Auto assign 
check box. 

11. In Host Identifiers, 
select the Auto assign 
radio button. 

12. Select the 
Automatically start 
this server when the 
Server Intelligence 
Agent starts check 
box. 

 

In SAP Crystal Reports Viewing 
and Modification Service, 

13. In Temporary 
Directory, if there is a 
value, make sure the 
path is valid.  

 

14. Enable the Guest 
account in Users and 
Groups -> User List. 
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Step  

15. When you have 
finished making 
configuration 
changes, restart the 
Report Application 
Server. 

 TIP: The Report 
Application Server is on 
the second page of 
servers. 

 

 

Configure the SAP Crystal Report Server on Linux 

The IBM TRIRIGA Java data source must reside on the SAP Crystal Report Server. If it does not, many 
reports will fail to run and will display a message similar to the following error: 

Could not open Report Client Document. Caused by: 
com.crystaldecisions.sdk.occa.report.lib.ReportSDKServerException: 
Failed to open the connection. 

You must have the following available to configure the SAP Crystal Report Server for Linux: 

 Oracle Client for Linux 11g - linux_x86_11gR1_client.zip (from Oracle) 

 unixODBC packages (yum install unixODBC* from RedHat) 

 Crystal Data Direct 6.0 Drivers for Linux  

 

To configure the SAP Crystal Report Server, make the following changes: 

Step  

1. Using a remote copy tool, such as WinSCP, navigate to the /tools/Crystal folder in the IBM 
TRIRIGA installation folder. 

For example: C:\Tririga\tools\Crystal 

2. Copy rowset.jar and TririgaCrystalClient.jar to the following folder:  
DirectoryWhereCrystalInstalled/sap_bobj/enterprise_xi40/dataAccess/conne
ctionServer/beans. 

For example, into 
{install_path}/sap_bobj/enterprise_xi40/dataAccess/connectionServer/beans 
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Step  

3. On the SAP Crystal Reports Server, navigate to the SAP Crystal Reports installation directory, 
then to the /sap_bobj/enterprise_xi40/java folder. 

4. Edit CRConfig.xml to include TririgaCrystalClient.jar and rowset.jar in the 
classpath, as shown in the following example. Replace {install_path} with your actual 
BusinessObjects Enterprise install path. 

<JavaBeans> 
    <CacheRowSetSize>100</CacheRowSetSize> 
 <JavaBeansClassPath>{install_path}/enterprise_xi40/dataAccess/connectionServ
er/beans/TririgaCrystalClient.jar:{install_path}/enterprise_xi40/dataAccess
/connectionServer/beans/rowset.jar</JavaBeansClassPath> 
 <CallBackFunction>CrystalReportsLogoff</CallBackFunction> 
</JavaBeans> 
 

 NOTE: Make sure the text starting with <JavaBeansClassPath> and ending with 
</JavaBeansClassPath> is on one line. 

 NOTE: Skip the next step if you are not using Oracle. 

5. Add the following lines to .bash_profile of your Crystal user. Replace {install_path} with the 
true path to the Crystal install dir 

export ORACLE_HOME=/usr/local/oracle/app/oracle/product/11.1.0/client_1/ 
 
export 
LD_LIBRARY_PATH=/usr/local/oracle/app/oracle/product/11.1.0/client_1/lib: 
{install_path}/sap_bobj/enterprise_xi40/linux_x86/odbc/lib 
 
export 
TNS_ADMIN=/usr/local/oracle/app/oracle/product/11.1.0/client_1/network/admi
n/ 
 
export ODBCINI={install_path}/sap_bobj/enterprise_xi40/odbc.ini 

 NOTE: Make sure each of the export statements is on one line. It is the format of this guide that 
splits them into more than one line. For example, the second export statement above should start: 
export LD_LIBRARY_PATH=/usr/local/or…. 

NOTE: Skip the next step if you are not using Microsoft SQL Server. 

6. In the Crystal user .bash_profile, add/modify the following environment variables and 
source the profile. Replace {install_path} with the true path to the Crystal install dir. 

 NOTE: IBM TRIRIGA only certifies BOE on Linux_x86. 

 
export BOBJEDIR={install_path}/sap_bobj 
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Step  

export ODBC_HOME={install_path} /sap_bobj/enterprise_xi40/linux_x86/odbc 
 
export ODBCINI={install_path} /sap_bobj/enterprise_xi40/odbc.ini 
 
export LD_LIBRARY_PATH={{install_path} 
/home/tririga/sap_bobj/enterprise_xi40/dataAccess/connectionServer:$ODBC_
HOME/lib:$LD_LIBRARY_PATH 

 

 NOTE: You must set/export the above env variables in the same order as shown. 

 NOTE: Make sure each of the export statements is on one line. It is the format of this guide 
that splits them into more than one line. 

●L1● 

 NOTE: Skip the next step if you are not using Oracle. 

7. Modify the {install_path}/sap_bobj/enterprise_xi40/odbc.ini to add the following: 

[TRIRIGAIBS] 
QEWSD=40442 
Driver={install_path}/sap_bobj/enterprise_xi40/linux_x86/odbc/lib/CRora24.so 
Description=DataDirect 6.0 Oracle Wire Protocol 
HostName=oracleserverhost 
ServiceName=orcl 
PortNumber=1521 
LogonID=tridata 
Password=password 
 

 NOTE: If you use a DSN name other than TRIRIGAIBS, it must match the TRIRIGAIBS_ODBC value 
in TRIRIGACRYSTAL.properties on the Application and Process servers. 

 

 

 NOTE: Skip the next step if you are not using Microsoft SQL Server. 

8. Modify the {install_path}/sap_bobj/enterprise_xi40/odbc.ini to add the following: 

[TRIRIGAIBS] 
QWESD=40442 
Driver={install_path}/sap_bobj/enterprise_xi40/linux_x86/odbc/lib/CRsqls24.so 
Description=DataDirect 6.0 SQLServer Native Wire Protocol 
HostName=sqlserver,1433 
Database=tridata 
LogonID=tridata 
Password=password 
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Step  

EnableQuotedIdentifiers=1 
AnsiNPW=0 

 NOTE: If you use a DSN name other than TRIRIGAIBS, it must match the TRIRIGAIBS_ODBC 
value in TRIRIGACRYSTAL.properties on the Application and Process servers. 

●L1● 

DataDirect provides both NON-OEM drivers and OEM drivers. The drivers provided by BOE XI are OEM 
drivers. By default the Connection Server is set to use NON-OEM drivers. You must edit the Connection 
Server to allow the use of the OEM branded DataDirect driver. The steps are as follows: 

9. Make a backup copy of 
{install_path}/sap_bobj/enterprise_xi40/dataAccess/connectionServer/odbc/sql
srv.sbo 

10. Change the following parameter from No to Yes: <Parameter Name="Use DataDirect OEM 
Driver" Platform="Unix">Yes</Parameter> 

●L1● 

11. Stop all BOE XI servers, ./stopservers, log out completely from your UNIX shell, and log 
back in (to make sure new env variables are set up). Start all BOE XI servers. 

You should be able to run Crystal, Webi, or Deski reports using the DataDirect ODBC driver. 

After installing a Service Pack, the connection may hang on Webi without any errors. This is because 
Service Packs may overwrite the sqlsrv.sbo, which means that the parameters have been reset to 
the default. 

 NOTE: Skip the next two steps if you are not using Microsoft SQL Server with named instances. 

12. For a named instance of SQL Server, use the following format: 
server_name\instance_name. If only a server name is specified with no instance name, the 
driver connects to the server and uses the default named instance on the server. 

13. In the Universe.sbo file, make sure to define the correct version of Microsoft SQL Server for 
the connection. 

14. Start the Central Management Console. The default URL is 
http://localhost:8080/BOE/CMC. The User Name is Administrator and the Password is 
what you set during installation. 
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Step  

15. Navigate to Servers -> 
Servers List -> Report 
Application Server. 

 TIP: The Report 
Application Server is on 
the second page of 
servers. 

16. Right click and enable 
the server. 

17. Right click and stop 
the server. 

 

18. Right click and select 
Properties. 

 

In Command Line Parameters, 

19. Specify the “-ipport 
<port #>” for the 
server. Add it to the 
end of the Command 
Line Parameters. 

The default port is 1566. 
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Step  

In Common Settings, 

20. In Request Port, 
select the Auto assign 
check box. 

21. In Host Identifiers, 
select the Auto assign 
radio button. 

22. Select the 
Automatically start 
this server when the 
Server Intelligence 
Agent starts check 
box. 

 

In SAP Crystal Reports Viewing 
and Modification Service, 

23. In Temporary 
Directory, if there is a 
value, make sure the 
path is valid.  

 

24. Enable the Guest 
account in Users and 
Groups -> User List. 
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Step  

25. When you have 
finished making 
configuration 
changes, restart the 
Report Application 
Server. 

 TIP: The Report 
Application Server is on 
the second page of 
servers. 

 

 

Enabling Crystal support on WebSphere 8 
For Crystal support on WebSphere 8, the IBM TRIRIGA application needs to point to IBM ICU version 
4.8.1.1. To enable this, you must create a new shared library. 

To create the new shared library: 

Step 

1. Go to Environment > Shared Libraries. 

2. Select the server scope and click the New… button. 

3. For this new Shared Library, enter the name “TRIRIGA_IBM_ICU4_8_1_1”. 

4. Enter the classpath to the “icu4j-4_8_1_1.jar” file, which is located in the tools/lib directory 
of the IBM TRIRIGA installation. 

5. Select the check box for Use an isolated class loader for this shared library. 

6. Click OK. 

7. Click Save. 

8. To go to the IBM TRIRIGA application, go to Application Types > WebSphere Enterprise 
Applications.  
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Step 

9. Select the IBM TRIRIGA application. 

10. Under References in the Configuration tab, click Shared library references. 

11. Select the check box for the IBM TRIRIGA application and click the Reference shared libraries 
button. 

12. Select “TRIRIGA_IBM_ICU4_8_1_1” from the list of available Shared Libraries and click the 
arrow pointing to the right. This will places the “TRIRIGA_IBM_ICU4_8_1_1” Shared Library into 
the “Selected” list. 

13. Click OK. 

14. Confirm that the “TRIRIGA_IBM_ICU4_8_1_1” Shared Library appears as a referenced Shared 
Library for the “tririga-ibs” application and click OK. 

15. Click Save. 
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3. Verifying Installation 
This chapter provides information that you can use to help confirm that your system is running 
properly. The tips below are not intended to substitute for your company’s testing and validation 
procedures. 

Installation Verification Tips 

Review the ant.log. The ant.log is located in the root installation directory, for example 
C:\Tririga\ant.log. This file contains information about every step taken during the install. A 
line toward the end of the file indicates whether the installation succeeded or failed. 

Sign in as the system user. The default User Name is system and the default Password is admin. 
The complete portal should display and all colors and fonts should be readable. 

Login to the Administrator Console. The default login is system and the default Password is admin. 
In the Agent Manager, start at least the following agents in the Process Server: CleanupAgent, 
ExtendedFormulaAgent, FormulaRecalcAgent, SchedulerAgent, WFAgent, and WFNotificationAgent. 
Logout of the Administrator Console. For more information about the Administrator Console, read 
the IBM TRIRIGA Application Platform 3 Administrator Console User Guide. 

As the system user, create a non-admin Employee. Make them an IBM TRIRIGA user. Give them some, 
but not all, user groups. Give them some, but not all, user licenses. 

Sign in as the user you created. Check that the user has access to everything they should have access 
to with the security groups and licenses given.  

Check that a user can create and revise records, especially People and Location records. 

Open a record and select the Associations tab. Verify that the Association Tree loads. 

In the Workflow Builder, (as delivered, it is under Tools > Builder Tools), open and revise an existing 
workflow. Navigate to see if it loads completely. 

In the Data Modeler (as delivered, it is under Tools > Builder Tools), verify that the state transition 
loads. Publish a test business object to verify that SMTP e-mail notification works. 

As either the system user or a user with rights, open the Document Manager (as delivered, it is under 
the Tools menu item). 

Upload a new document (txt, html, or jpg are good tests). 

Upload a new document with the MultiFile applet. 

View the document by clicking the icon in the V column. 

Check In / Check Out a document. 
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If Brava! has been installed, upload a CAD document in DXF and view the CAD document by clicking 
the icon in the V column. 

If SAP Crystal Reports has been installed, test the operation of the Crystal integration. 

Open an Employee record, select the Reports tab, and click Submit. 

Open a Building record, select the Reports tab, choose Building Report, and click Submit. 

In the My Reports menu item, select the Community tab. Enter Location in the Module filter, 
choose Crystal from the Display Type filter, and click Apply Filters. Select the Run Report icon  
next to a report. 

Test functions dependent on the X Window System (X). 

SAP Crystal Reports: In the My Reports menu item, select the Community tab. Enter Capital 
Project in the Business Object filter, choose All from the Display Type filter, and click Apply 
Filters. Select the Run Report icon  next to a report. 

Open or create a new Capital Project. In the Schedule tab, Add or test a Schedule Task in the 
Project Tasks section. In the Schedule Task line item, change one of Planned Start, Planned End, or 
Planned Working Hours. The other fields should adjust accordingly. 

If CAD Integrator will be used, select the following options: 

Sign in as a user with a CI license. 

Sync a drawing with CI. 

Verify that the server.log exists and is being written to. The server.log is located in the log 
directory of the IBM TRIRIGA install, for example C:\Tririga\log\server.log. 

Check the server.log for any major exceptions on first startup. 

If the environment being verified is a performance environment like Production, check 
TRIRIGAWEB.properties to make sure ProductionMode=Y instead of the default value of N. 

A day or so after the install, verify in the Process Server server.log that the Cleanup process 
completed successfully. Verify this on a regular basis. 
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4. IBM TRIRIGA Software Configurations 
This guide provides details about some of the key areas that need to be configured for the IBM TRIRIGA 
Application Platform and the applications that run on it to work properly. Although the installer 
provides most of the configurations necessary, it is important to understand what the various 
configurations are and where changes can be made to optimize your environment. 

Properties Files 

The IBM TRIRIGA properties files are located in the config directory of your IBM TRIRIGA installation, 
for example, C:\tririga\config. 

The properties files use the concept of “name-value pairs” where a variable name is followed by an 
equals sign (=) and then the defined value. Lines in the properties files that begin with a pound sign (#) 
are comments and not read by the system. Name-value pairs are case sensitive. 

Some properties need to be set only when they apply to your company implementation of IBM TRIRIGA. 

 TIP: The variables and settings in IBM TRIRIGA properties files may change from one version to 
the next. Before upgrading from a prior version of IBM TRIRIGA software, save your old properties 
files. After completing your upgrade install, carefully review each newly installed properties file 
and adjust values as appropriate for your implementation. 

Information about the IBM TRIRIGA properties files for Crystal is included here. For more information 
about the IBM TRIRIGA properties files, go to the IBM TRIRIGA Application Platform 3 Knowledge Center 
and select Installing IBM TRIRIGA Application Platform. 

TRIRIGACRYSTAL.properties 

Variable Name Acceptable 
Values Description of Use 

ReportLocation Valid path Where the SAP Crystal Reports rpt files are 
stored when uploaded into Document 
Management. This should be the install 
/userfiles/crystalreports directory. 

For example: 
C:/Tririga/userfiles/crystalrepor
ts 

RasHost Host name The Crystal Decisions Report Application 
Server. 

AppHost String The URL used to view an offline SAP Crystal 
Report. The value must be a valid host 
name (not localhost, not 
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Variable Name Acceptable 
Values Description of Use 

12.34.56.78). Include the port number if 
the Application Server is not using port 80 
(e.g., term4.ibm.com:8001). Do not 
include the protocol (http://) or the path 
(/index.html).  

TRIRIGAIBS_ODBC String Any Crystal report that runs direct SQL 
against an IBM TRIRIGA database must have 
a data source named TRIRIGAIBS. This 
refers to an ODBC entry that resides on the 
Crystal RAS server. 

A single RAS server can service any number 
of IBM TRIRIGA database servers. Do not use 
this for a production RAS server, but it can 
be useful in other environments, such as 
development. 

The TRIRIGAIBS_ODBC property 
configures which ODBC entry on the Crystal 
RAS server the reports will use. Begin by 
creating ODBC entries on the RAS server, 
one for each database hosting an IBM 
TRIRIGA instance to be supported by the 
RAS server. In the IBM TRIRIGA application 
server, configure the TRIRIGAIBS_ODBC 
property to indicate which ODBC entry 
should be used for reports run from that 
server. At runtime, the TRIRIGAIBS data 
source is replaced in the report with the 
name of the ODBC entry specified in the 
TRIRIGAIBS_ODBC property. 

If a value is specified in the 
TRIRIGAIBS_ODBC property, the 
TRIRIGAIBS value in a Crystal report will 
be replaced with that value. If the property 
is left blank, the TRIRIGAIBS data source 
will remain in the report. 

ReportUserLogon String The username used to logon to non-IBM 
TRIRIGA data sources that are used in 
reports. 

 NOTE: This value can be plain text or 
encrypted. See the IBM TRIRIGA 
Application Platform 3 Administrator 
Console User Guide for information 
about the encryption tool. 
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Variable Name Acceptable 
Values Description of Use 

ReportUserPassword String The password for the logon to non-IBM 
TRIRIGA data sources used in reports. 

 NOTE: This value can be plain text or 
encrypted. See the IBM TRIRIGA 
Application Platform 3 Administrator 
Console User Guide for information 
about the encryption tool. 

CRYSTAL_MEMORY_USAGE_LIMIT 0 – 100 

Blank 

The maximum percentage of available 
server memory that can be used while 
assembling query results for a Crystal 
report. If this percentage is exceeded, the 
query errors out due to insufficient 
memory. If this is caused by an interactive 
Crystal report, the following error message 
is displayed: “Error Occurred. There are not 
enough resources available to run the 
report at this time. – [MID-xxxxx]”, where 
xxxxx is the message ID of the log entry in 
the server.log. 

Before the report actually fails, the 
platform attempts to reclaim unused 
memory by doing a garbage collection. This 
garbage collection has the potential to 
momentarily slow other activity on the 
system. Any attempt to reclaim unused 
memory will have an INFO-level log entry in 
the server.log. 

If you see a “There are not enough 
resources available to run the report” error 
for a query, it is likely that the query was 
the cause of the error; however, it also is 
possible that other concurrent processes 
could have consumed memory while the 
query was assembling its results. 

Valid values are between 0 and 100. Values 
of 0 and 100 essentially disable any limit 
being enforced. Do not use either value 
because a single query initiated by a single 
user could run the server out of memory. 

An empty value or an invalid value is 
treated as a default value. 

The default value is 35. 
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Variable Name Acceptable 
Values Description of Use 

CRYSTAL_REQUEST_SERVER_PORT Number A Crystal Request Server resides within the 
IBM TRIRIGA Application Server. When 
present, this property specifies the listening 
port on the IBM TRIRIGA server that handles 
Crystal RAS Query Requests. If no port is 
specified, the system selects an available 
port. 

ServletUser String The username that is hard coded to prevent 
manual requests for portal and section 
reports. 

 NOTE: This value can be plain text or 
encrypted. See the IBM TRIRIGA 
Application Platform 3 Administrator 
Console User Guide for information 
about the encryption tool. 

ServletPassword String The password that is hard coded to prevent 
manual requests for portal and section 
reports. 

 NOTE: This value can be plain text or 
encrypted. See the IBM TRIRIGA 
Application Platform 3 Administrator 
Console User Guide for information 
about the encryption tool. 

ReportCacheSize Number The number of reports that can be cached, 
meaning that they will not have to be 
reprocessed while navigating through the 
report. 

OwnPage true 

false 

The default value is true. 

DisplayLogo true 

false 

If set to true, the Crystal Business 
Objects/SAP logo is displayed in the viewer. 

The default value is false. 

EnableDrillDown true 

false 

If set to true, drill down is enabled. 

The default value is true. 

ExportButton true If set to true, the Export Button is 
displayed. 
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Variable Name Acceptable 
Values Description of Use 

false The default value is true. 

GotoPageButton true 

false 

If set to true, the Goto Page button is 
displayed and the HTML returned includes a 
text box into which the user can type a 
page number to navigate to a specific page 
in the report. If set to false, the HTML 
returned displays the current page but does 
not allow the user to navigate by page 
number.  

The default value is true. 

ToolPanelViewType GroupTree 

ParameterPanel 

None 

The default value is None. 

GroupTreeToggle true 

false 

If set to true, the group tree toggle button 
is displayed. 

The default value is true. 

ParameterPanelToggle true 

false 

If set to true, the parameter panel toggle 
button is displayed. 

The default value is true 

MultiplePages true 

false 

If set to true, the report is displayed as 
multiple pages. If set to false, the report is 
displayed as one long page. 

The default value is true. 

PageNavigation true 

false 

If set to true, the page navigation buttons 
(Next/Previous) are displayed. 

The default value is true. 

PrintButton true 

false 

If set to true, the Print button is displayed. 

The default value is true. 

PrintMode ActiveX 

PDF 

Controls the report print feature. 

If set to ActiveX, users print a report from 
their browser using ActiveX control. The 
client Web browser must support ActiveX 
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Variable Name Acceptable 
Values Description of Use 

control. 

If set to PDF, users save a report as a PDF 
file and print it from Adobe Reader. 

The default value is ActiveX. 

RefreshButton true 

false 

If set to true, the Refresh button is 
displayed. 

The default value is true. 

SearchButton true 

false 

If set to true, the Search button is 
displayed. 

The default value is true. 

Toolbar true 

false 

If set to true, the toolbar is displayed. 

The default value is true. 

ZoomFactorList true 

false 

If set to true, a zoom factor list is 
displayed. 

The default value is true. 

DrillDownTabs true 

false 

If set to true, drill down tabs are displayed. 

The default value is true. 

ToolPanelWidthUnit Pixel The unit of measure for the tool panel 
width. 

The default value is pixel. 

ToolPanelWidth Number The width of the tool panel in the units 
specified in ToolPanelWidthUnit. 

The default value is 200. 

StartPage Number The page number of the beginning of a 
report. 

The default value is 1. 

ZoomFactor Number Sets the zoom factor for displaying a report. 

The default value is 100. 
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Variable Name Acceptable 
Values Description of Use 

ViewerTitle String The title displayed at the top of the viewer. 

The default is IBM TRIRIGA Report 
Viewer. 

HyperLinkTarget _self 

_parent 

_top 

_blank 

The hyperlink target for displaying the 
HTML. 

_self displays the HTML in the same frame 

_parent displays the HTML in the same 
frame or window that contains the current 
frameset 

_top displays the HTML in the entire 
browser window 

_blank displays the HTML in a new browser 
window 

The default value is _blank. 

StyleSheetLocation Name The name of the style sheet. 

The default value is tririga.css. 

ReportLifeSpan Number How long a report generated by the Report 
Queue Agent should exist on the disk after 
it has been created. 

The default value is 15. 

ReportCleanTime 0 – 23 The hour at which the reports that have 
passed the ReportLifeSpan limit are 
deleted, in 24-hour time.  

The default value is 2. 

TRIRIGAWEB.properties 

Variable Name Acceptable 
Values Description of Use 

ReportQueueAgentLoad Number The number of threads in proportion to the 
number of connections (e.g., 100.0) 
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Variable Name Acceptable 
Values Description of Use 

ReportQueueAgentMaxThreads Number The maximum number of threads that can 
be used to run queued reports. If there is 
no upper limit, set to 0. 

 



  Installation Verification Tips 

© Copyright IBM Corporation 2011, 2016.       29 
  

5. Working with SAP Crystal Reports 

Setup for Data Sources 
There are two different types of Crystal reports: form reports and query reports. Form reports are used 
most often to display the contents of a single record. Form reports generated by SAP Crystal Reports 
contain data from one top-level record. They may contain data from one or more associated records 
and are used to create reports users can select on the Reports tab of a record or when a user clicks 
Form for a single record. Query reports are used most often to display multi-record reports. Query 
reports may contain data from any number of top-level records and multiple levels of detail that are 
accessible through associated business objects and records. 

You can use SAP Crystal Reports to create form reports as well as query reports. 

IBM TRIRIGA is a web-based application and its data structure is defined in the Data Modeler. The data 
schema for IBM TRIRIGA business objects is available through ADO XML. You can connect to IBM TRIRIGA 
data either through ADO XML or by direct database access. The following chart summarizes the pros 
and cons of each approach. This chapter assumes your choice is the ADO XML approach. 

Connection 
Method Pro Con 

ADO XML  Report development is easier 

 Each field of a business object 
(including smart section field) is 
available in the XML 

 Naming conventions used by XML 
make it easy to locate any field 
(Section Name_Field Name) 

 IBM TRIRIGA security is enforced 
on the data that is being accessed 

 Can take advantage of associations 

 Can use IBM TRIRIGA filters 

 Performance is slower than through 
directly accessing the data from 
the tables 

 During development, report has to 
be uploaded into Document 
Manager each time to test the 
report 

Direct 
connection to 
IBM TRIRIGA 
database 

 Performance is better, since you 
are directly connected to database 

 Testing can be done, by saving the 
RPT and running it directly from 
the local machine 

 RPT file can be uploaded into 
Document Manager only once 

 Developer needs to be familiar with 
the IBM TRIRIGA database schema, 
naming convention, and the like 

 Unlike XML, explicit joins need to 
be made from one table to another 

 Bypasses IBM TRIRIGA security rules 

 If the database schema changes, 
the reports may need to be 
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Connection 
Method Pro Con 

updated 

An ADO XML data source needs to be set up on any machine that will be used to develop Crystal 
reports. This allows the Crystal Designer to retrieve the data structure information defined by the form 
(for a form report) or query (for a multi-record report) ADO XML files. 

If you are familiar with Microsoft Corporation’s .NET technology, you may be aware that ADO.NET can 
use ADO XML files as a data source. The files that the IBM TRIRIGA Application Platform generates are 
not intended to be used as true data sources. They are intended to be used with SAP Crystal Reports to 
design reports. They only contain a single row of metadata information representing the IBM TRIRIGA 
object data structure to help you lay out a report. 

You only need to set up for data sources once on a Crystal report developer’s computer. Begin 
establishing the Crystal data sources you will need to create form reports and query reports by creating 
the following directory structure on a computer that will be used for designing Crystal reports. 

• First, create a folder named XML_Data_Source. 

• Create a folder within XML_Data_Source named Forms. 

• Create another folder within XML_Data_Source named Queries. 

Form Reports 
Form reports are used in a record’s Reports tab or when a user clicks the Form action for a single 
record. Before creating a Crystal report for a form report, review the information displayed 
automatically by the system when the user clicks the Print Preview link. Form reports generated by SAP 
Crystal Reports contain data from one top-level record. They also may contain data from one or more 
associated records contained within query sections on the top-level record’s form. 

You only need to create a data source for form reports once on a Crystal report designer’s computer. 

If you wish to include associated records that are contained within query sections of the top-level 
record’s form you do not need to create a separate query-based ADO XML data source. The Forms ADO 
XML files will contain the top-level business object definition as well as business object definitions for 
all associated objects represented within query sections on the top-level record’s form. When a form 
Crystal report runs, the IBM TRIRIGA Application Platform returns the top-level record and only those 
associated records contained within the top-level record’s query sections. No joins need to be defined 
within the Crystal report as all data is pre-filtered for inclusion on the report. 

The remaining steps in this section are the same for each form report you wish to create: 

• Use the Form Builder to create the ADO XML 

• Design and create the Crystal report 
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• Put the report file into the Document Manager 

• Add the report to the form 

The examples in this section use a report that list an employee’s information. 

Create a Data Source 

You only need to create a data source for form reports once on a Crystal report designer’s computer. 
Follow these steps to create the data source for the report. 

Step 

1. Click Start > Settings > Control Panel. 

2. Select Administrative Tools. 

3. Select Data Sources (ODBC). 

4. Select the System DSN tab. 

5. Click Add. 

6. Select CR XML ODBC Driver 6.0. 

7. Click Finish. 

8. Enter TririgaFormsXML in Data Source Name. No other name should be used for this value. 

9. Click Add to add a location. 

Add a location named Forms to the TririgaFormsXML data source using the Forms directory as 
the source: 

10. Enter Forms in Location Name. 

11. Select the Folder radio button in Location Type. 

12. Click the  box and find the XML_Data_Source\Forms directory you created earlier. 

13. Click Apply. 

14. Select the Advanced tab. 
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Step 

15. In Table Creation, select the ADO Format radio button. The data source location then uses ADO 
format. 

16. Click Apply. 

To finish, 

17. Click Close. 

18. Click OK. 

19. Click OK. 

Use the Form Builder to Create the ADO XML 

The ADO XML files contain information about the data in the IBM TRIRIGA system that the report will 
run against. 

You will find naming conventions for reports in Naming Conventions in this user guide. 

Step 

1. Select the Form Builder option from the Application Builder portal section. 

2. Scroll the Module panel and select the module for the report (in this example, triPeople). 

3. Select the form in the right panel by selecting the radio button (in this example, 
triEmployee). 

4. There are two ways to select the ADO XML: 

Either, 

(1) Click the ADO XML v2 action on the section bar. 

 Note – The ADO XML v1 action is for legacy reports created prior to TRIRIGA 
Application Platform 2.7.0. 

 

Or,  

(2) If the form is published, open the form and click the ADO XML v2 action on the Layout tab. 

 Note – The ADO XML v1 action is for legacy reports created prior to TRIRIGA 
Application Platform 2.7.0. 
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Step 

The platform generates a zip file that contains the ADO XML files SAP Crystal Reports will use. 

5. Click Save. 

6. Save the zip file in the XML_Data_Source\Forms directory created in Setup for Data 
Sources. 

7. Extract the contents of the zip file into the Forms directory. 

 Tip – See ADO XML v2 Formats for an explanation of the name format. 

 

 Note – For form query sections, the platform only pulls the Display Columns, the 
field labels, and the UOM fields from the backing query of the query section. 

 

 Attention – Do not rename the XML files. 

 

 Tip – After you finish creating a report, open the XML_Data_Source \Forms 
folder and delete the files. When you do so, the next time you create a report you 
only will be working with the XML files for the new report. 

 

Design and Create the SAP Crystal Report 

Explaining how to use SAP Crystal Reports to design a report is beyond the scope of this user guide. Any 
good book on designing reports for SAP Crystal Reports should be helpful. 

 Note – For information about form reports when you have selected the ADO XML v1 action, 
go to ADO XML v1. 

An important detail you should be aware of when you are designing a form report: For every field in 
the report there will be two fields available in SAP Crystal Reports. One field will have the same name 
as the field. The other field will have the name of the field followed by _Label. 

For example, the General section of an Employee record has a field named triNameTX. In a form 
report, SAP Crystal Reports will see a field named triPeople_triEmployee__triNameTX that 
contains the value of the triNameTX field. SAP Crystal Reports also will see a field named 
triPeople_triEmployee__triNameTX_Label that contains the label for the triNameTX field. 
When you put a label in a report, use the field name ending with _Label instead of a text object. This 
ensures the label for the field stays consistent with the label specified for the field in the form. If the 
field label is changed in the form, the field label will show the new value the next time the report is 
run. 
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Another benefit of using the field name ending with _Label instead of a text object is that it allows 
the report to take advantage of the IBM TRIRIGA Application Platform’s internationalization support for 
labels. If configured to do so, the platform can supply labels in the language preferred by the user. For 
more information, go to the IBM TRIRIGA Application Platform 3 Knowledge Center and select 
Administering IBM TRIRIGA Application Platform > Localizing applications. 

The following example uses the XML extracted in the previous section and the Standard Report 
Creation Wizard to show some of the steps in designing and creating a Crystal form report: 

Step 

1. In the Available Data Sources panel, expand the Create New Connection folder. 

2. Click the + next to ODBC (RDO). 

3. Select TririgaFormsXML in the Data Source Name list. 

4. Click Finish. 

5. In the Available Data Sources panel, expand the XML node under ODBC 
(RDO)\TririgaFormsXML. 

6. Select the table with the same name as the module your report belongs to (in this example, 
[v2BO]triPeople_triPeople). 
 

 Tip – See ADO XML v2 Formats for an explanation of the name format. 

 

7. Click the right facing arrow to move the table to the Selected Tables panel. 

8. Click Next. 

9. In the Available Fields panel, select the fields you want on your report and use the right facing 
arrow to move them to the Fields to Display panel. 

 Tip – See ADO XML v2 Formats for an explanation of the name format. 

 

 Note – As described above, there are two fields for each field in the database. The 
one ending _Label is the field label from the form. 

 

10. Click Next three times to bypass the Grouping and Record Selection options. 

11. Click Finish to close the wizard. 

12. Select the File menu and make sure the Save Data with Report option is NOT checked. 
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Step 

13. Arrange the fields as desired. 

14. Save the report as a .rpt file. 

 Tip – Note the location where you save the file. 

 

Put the Report File into the Document Manager 

For detailed instructions on how to use the Document Manager, see the IBM TRIRIGA 10 Document 
Management User Guide. 

Step 

1. Select the Document Manager from Tools menu item in the first level of the menu bar. 

2. Expand the IBM TRIRIGA folder. 

3. Select the folder corresponding to the module of the report (in our example, People). 

 Tip – Some companies prefer to create new folders for customized reports or 
folders for individuals. 

 

4. Click New Document. 

5. Click Browse… and select the rpt file you created. 

6. Enter a Document Name. 

7. Enter other fields per your company’s policies and procedures. 

8. Click Upload. 

9. Click OK when the upload process completes. The report now shows in the list in the Document 
Manager. 

Add the Report to the Form 

Step 

1. Return to the Form Builder. 
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Step 

2. Open and Revise the form for which you developed the form report (in our example, 
triEmployee). 

 Tip – If you want this report to appear in the Reports tab, ensure the Show Reports 
property is selected on the Layout tab. 

 

3. Select the Includes/Forms tab. 

4. Click Add on the Forms section bar. 

5. Search for and select the document you uploaded into the Document Manager. 

6. Click OK. 

7. Return to the Layout tab and Publish the form. 

To Make Changes to a Form Report 

If changes need to be made to a form report, you will need to check out the report from the Document 
Manager, make your changes, and check in the report. The IBM TRIRIGA 10 Document Management User 
Guide describes this process in detail. 

Step 

1. To check out the file, locate the file in the Document Manager and click the Check Out icon . 

2. Enter an appropriate Comment. 

3. Click Check Out. 

Select the option that best matches your requirement: 

4. Click Open to create a temporary file named <filename>[1].rpt that opens in Crystal. 

5. Click Save if you do not have a copy of the .rpt file or if you are not sure that the file you have is 
the most current. 

6. Click Cancel if you have been working on the report in Crystal. This changes the status in the 
Document Manager without copying the file anywhere. 

7. Make your changes to the report and save the file.  

8. Upload the new version by checking the file back in to the Document Manager. Start by selecting 
the Check In icon . 
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Query Reports 
Query reports may contain data from any number of top-level records. They also may contain multiple 
levels of detail that are accessible through associated business objects and records. Most often query 
reports are used to display multi-record reports. 

You only need to create a data source for query reports once on a Crystal report designer’s computer. 

You do not need to create a data source for queries if you are designing a form report for a record that 
contains query sections. 

The steps are the same for each query report you wish to create: 

• Use the Report Manager to create a source query and the ADO XML 

• Design and create the Crystal report 

• Put the report file into the Document Manager 

• Create an External IBM TRIRIGA report in the Report Manager to link to the Crystal report (.rpt) 
file 

• View the report from the manager 

The examples in this Query Reports section use a report that lists employees. 

Create a Data Source 

You only need to create a data source for query reports once on a Crystal report designer’s computer. 
Follow these steps to create the data source for the report. 

Step 

1. Click Start > Settings > Control Panel. 

2. Select Administrative Tools. 

3. Select Data Sources (ODBC). 

4. Select the System DSN tab. 

5. Click Add. 

 Note – The TririgaIBS data source is defined on the Crystal server. 
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Step 

6. Select CR XML ODBC Driver 6.0. 

7. Click Finish. 

8. Enter TririgaQueriesXML in Data Source Name. No other name should be used for this value. 

9. Click Add to add a location. 

Add a location named Queries to the TririgaQueriesXML data source using the Queries 
directory as the source: 

10. Enter Queries in Location Name. 

11. Select the Folder radio button in Location Type. 

12. Click the  box and find the XML_Data_Source\Queries directory you created earlier. 

13. Click Apply. 

14. Select the Advanced tab. 

15. In Table Creation, select the ADO Format radio button. The data source location then uses ADO 
format. 

16. Click Apply. 

To finish, 

17. Click Close. 

18. Click OK. 

19. Click OK. 

Use the Report Manager to Create a Source Query and the ADO XML 

The following steps create a new query that will provide the Crystal report with the data structure 
needed to design the report and the data for the report runtime. 

The ADO XML file contains the information about the data in the IBM TRIRIGA system that the report 
will run against. 

If you have questions about how to use the Report Manager, see the IBM TRIRIGA Report Building 
chapter in this user guide. You will find naming conventions for queries in Naming Conventions. 
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Step 

1. Select the System Reports tab on the My Reports menu item. 

2. Click New. 

3. Complete the General tab. The Type must be Query. 

 Note – Do NOT choose Type = External for the source query. 

 

4. Select the fields in the Columns tab. 

5. Select the Group By and Order By values in the Order & Group tab. 

6. Add any filters in the Filters tab. 

 Tip – Always filter the data as much as possible in the IBM TRIRIGA source query. 

 

7. In the Advanced tab, click ADO XML v2. 

 Note – The ADO XML v1 action is for legacy reports created prior to TRIRIGA 
Application Platform 2.7.0. 

 

The platform generates an XML file containing the ADO XML information SAP Crystal Reports will use. 

8. Click Save. 

9. Save the XML file in the XML_Data_Source\Queries directory created in Setup for Data 
Sources. 

 Attention – Do not change the file name. 

 

 Tip – After you finish creating a report, open the XML_Data_Source \Queries 
folder and delete the file. When you do so, the next time you create a report you 
only will be working with the XML file for the new report. 

 

Design and Create the Crystal Report 

Explaining how to use SAP Crystal Reports to design a report is beyond the scope of this user guide. Any 
good book on designing reports for SAP Crystal Reports should be helpful. 
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 Note – For information about query reports when you have selected the ADO XML v1 
action, go to ADO XML v1. 

The following example uses the XML extracted in the previous section and the Standard Report 
Creation Wizard to show some of the steps in designing and creating a Crystal query report: 

Step 

To create a connection to the XML file, 

1. In the Available Data Sources panel, expand the Create New Connection folder. 

2. Click the + next to ODBC (RDO). 

3. Select TririgaQueriesXML in the Data Source Name list. 

4. Click Finish. 

5. In the Available Data Sources panel, expand the XML node under ODBC 
(RDO)\TririgaQueriesXML. 

6. Select the table with the same name as the XML file (in this example, 
[v2QRY]triPeople_triPeople…). 

 Tip – See ADO XML v2 Formats for an explanation of the name format. 

 

7. Click the right facing arrow to move the table to the Selected Tables panel. 

8. Click Finish. 

 Tip – Click File > Options. Select the Layout tab. Turn off the Insert Detail Field 
Headings field option. Also, on the Database tab, select Sort Fields Alphabetically. 

 

9. Add fields to the report. 

 Tip – See ADO XML v2 Formats for an explanation of the name format. 

 

10. Select the File menu and make sure the Save Data with Report option is NOT checked. 

11. Save and exit the report. 
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Put the Report File into the Document Manager 

For detailed instructions on how to use the Document Manager, see the IBM TRIRIGA 10 Document 
Management User Guide. 

Step 

To find the Document Manager, select the Tools menu item on the first level of the menu bar, then 
select Document Manager on the second level of the menu bar. 

1. Expand the IBM TRIRIGA folder. 

2. Select the folder corresponding to the module of the report (in our example, People). 

 Tip – Some companies prefer to create new folders for customized reports or 
folders for individuals. 

 

3. Click New Document. 

4. Click Browse… and select the rpt file you created. 

5. Enter a Document Name. 

6. Enter other fields per your company’s policies and procedures. 

7. Click Upload. 

8. Click OK when the upload process completes. The report now shows in the list in the Document 
Manager. 

Create a Crystal IBM TRIRIGA Report in the Report Manager 

This creates a new IBM TRIRIGA query as an External query. This query will act as a link to the 
Crystal .rpt file in the Document Manager. 

If you have questions about how to use the Report Manager, see the IBM TRIRIGA Application Platform 
3 Reporting User Guide. 

Step 

1. Select the System Reports tab on the My Reports menu item. 

2. Click New. 



  Installation Verification Tips 

© Copyright IBM Corporation 2011, 2016.       42 
  

Step 

In the General tab, the Type must be External. 

3. In the Business Objects sub-tab, for Business Object, specify where users will be able to see this 
Crystal report. This value does not define the data that is available to the Crystal report (that 
was done above), rather it specifies where a user can access the Crystal report. 

 Tip – To select multiple items, hold the Ctrl or Shift key and click your selections. 

 

In the Options sub-tab, 

4. Select the Search icon  next to Document. 

5. In the IBM TRIRIGA Data Search form, point the query to the Crystal report you put into the 
Document Manager and click Accept. 

 Tip – In the IBM TRIRIGA Data Search form, use the % character as a wild card to 
widen your search from the first word to any word in the name. For example, type 
%Employee to find a report with the word Employee anywhere in the name. 

 

The Queued check box is available only when the report Type is External. Selecting the Queued 
check box indicates the report is to be run in a queued manner. 

If a queued report has runtime filters and/or Crystal filters, they are presented to the user before 
the report is queued, just like they are for a non-queued report. 

Queued Crystal reports may be launched from and/or are accessible from the following places: My 
Reports, Manager query lists, Report Manager, and query sections. 

The following access points are not supported for queued reports: Portal Sections (if a queued report 
is attached to a portal section, the system launches it in a non-queued manner) and form actions. 

 Note – When a queued report finishes processing, the system sends a notification to 
the user’s Notifications portal section. The user can access the report by clicking 
the hyperlinked Subject. 

 

 
Attention – A queued Crystal report attached to a workflow notification executes 
along with the notification. However, if the report contains filters that do not have 
a default value, the report generation may error out because there is no user to 
provide the values. Set the default values for all filters when you define such a 
report. 

6. If appropriate, select the Queued check box. 
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View the Report 

In this example, the Crystal report is in the Community tab. 

Step 

1. Select the Run Report icon . The system generates the report and displays it in a separate 
window. 

To Make Changes to a Query Report 

If changes need to be made to a query report, you will need to check out the report from the 
Document Manager, make your changes, and check in the report. The IBM TRIRIGA 10 Document 
Management User Guide describes this process in detail. 

Step 

1. To check out the file, locate the file in the Document Manager and click the Check Out icon . 

2. Enter an appropriate Comment and click Check Out. 

Select the option that matches your requirement: 

3. Click Open to create a temporary file named <filename>[1].rpt that opens in Crystal. 

4. Click Save if you do not have a copy of the .rpt file or if you are not sure that the file you have is 
the most current. 

5. Click Cancel if you have been working on the report in Crystal. This changes the status in the 
Document Manager without copying the file anywhere. 

6. Make your changes to the report and save the file.  

7. Upload the new version by checking the file back in to the Document Manager. Start by clicking 
the Check In icon . 

Printing Crystal Reports 
IBM TRIRIGA offers two modes for printing Crystal reports. One uses ActiveX control to send a report 
directly to the printer. The other exports a report to a PDF file that can be printed from Adobe Reader. 
For the ActiveX mode, the client Web browser must support ActiveX control. 
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Step 

1. The PrintMode property in the TRIRIGACRYSTAL.properties file determines which 
mode your users experience. The default is ActiveX, which sends a report directly to the 
printer. To export a PDF file, set the property to PDF. Additional information about 
setting the PrintMode property in the TRIRIGACRYSTAL.properties file can be 
found in the TRIRIGACRYSTAL.properties section. 

Naming Conventions 
IBM TRIRIGA follows a set of naming conventions in its applications and in custom development that it 
does on behalf of its customers. Follow these naming conventions to reduce unexpected interactions 
between IBM TRIRIGA’s applications and applications created by others and to help ensure that future 
upgrades go more smoothly. 

Element Naming Convention 

Name Prefix A three character customer prefix is assigned to all implementations, 
typically cst. For IBM TRIRIGA applications, the prefix is tri. 

Report or Query cst+“-” + Form Name (or Business Object Name or Module Name if 
Report/Graph) – Keyword – Context 

There are no spaces between the cst- and the tri object name. 

For example: cst-triPurchaseOrder – Workflow – POs for 
Current Year 

 

If the query references a new or customized object: 

Form Name (or Business Object Name or Module Name) – Keyword – 
Context 

For example: cstEmployee – Crystal – Employee Contact 
Details 

 

Keywords are: 

Crystal Query with linked Crystal rpt document 

Debug Query to help isolate data issues 

Display Query to display data in query sections 

Filter Query to filter data for other queries via 
Association filters 



  Installation Verification Tips 

© Copyright IBM Corporation 2011, 2016.       45 
  

Element Naming Convention 

Find Query for Find action of a locator or section 

Formula Query to provide input values for extended 
formulas 

Graph Graph reports intended for end users 

Graphics Graphics Editor report 

GUIMetric Query for metric in a form 

HGrid Hierarchical query for nesting queries 

Patch Query used in patch helpers 

Portal Query for portal section 

Report Report intended for end users 

Reserve Calendar/Reserve-based query of data 
associated with record 

Summary Summary Report intended for end users 

Subquery For the bottom level of an HGrid query 
structure 

Workflow Query for workflow Query task 

Context should include filters to states, data filters, association 
filters, if editable, and the like. For queries tied to a 
$$RECORDID$$ or other platform key, make sure to include the 
type of context record in the context part of the name. 

The ID of the report should be CUSTOM, or use your company’s 
numbering standards for reports. SYSTEM is reserved for IBM TRIRIGA 
delivered reports. 

Naming Convention for Labels: 

Form Label (or Business Object Label or Module Label) – Context 

Context should describe what the report displays to the user. 

For example: Employees – All Associated Active 
Employees 

Crystal Reports Tips 
Topic Tip 

$$DATEFORMAT$$ Return the $$DATEFORMAT$$ variable to a Crystal report to indicate 
which date format is preferred by a user. This way the report design 
can account for the different options present in your user 



  Installation Verification Tips 

© Copyright IBM Corporation 2011, 2016.       46 
  

Topic Tip 

community. 

Add A Field If the field was selected in the original design, modify the Crystal 
report and check the updated version into the Document Manager. 

If the field was not in the original design,  

• For a form report, recreate the ADO XML and update the Crystal 
report. 

• For a query report, open the query and add the field. After 
applying your changes, recreate the ADO XML file. Update the 
Crystal report. 

In Crystal you will need to select Database > Verify Database to 
refresh the dataset with the new field that was added to the IBM 
TRIRIGA query. 

Bulk Printing Follow these steps to bulk print Crystal reports: 

1. Go to the Data Modeler and verify that the triRecordIdSY 
field exists on the business object of the records you will be 
printing. If not, find the field and add it to the business object’s 
General section. 

2. Create a query for the business object you will be printing to 
return only the triRecordIdSY field. You can add static field 
filters and/or association filters to modify result set. For 
example, if the records to be printed will be determined by the 
user selecting them in a query section, you might use an 
association filter to filter using the $$RECORDID$$ record (i.e., 
the record containing the query section) for the selected 
records. 

3. On the Advanced tab of the query, click the ADO XML v2 action. 
Click Save when prompted and copy the name of the ADO XML 
file given without the [v2QRY] prefix and without the .xml 
extension. Cancel out of the download prompt. There is no need 
to save the XML document as you only need the name. You will 
need this name later to build the URL to send to Crystal. 

4. In the Document Manager, find the report you want to print in 
bulk. Open it and copy either the File Path value, or get the 
documentId by right-clicking on the link used to open the 
document record, going to properties and copying the docId 
from the Address (URL) path there. The address will be 
something like javascript:openDocument(4054908); Copy 
the number from within the parentheses. 

5. The URL that is built takes either parameter("reportPath" or 
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Topic Tip 

"docId"), but not both. By using the docId as an attribute in the 
RepBuilder.jsp URL (see example below), you have the 
ability to move the report around in the Document Manager 
without having to go back to the bulk printing URL later and 
change the path. The docId will always remain the same. 

6. Now that you have everything set, you can build your URL. 

Take the name of the ADO XML file you copied earlier (omitting 
the [v2QRY] prefix and the .xml at the end of it). This is what 
your queryName will be. 

For this explanation, we'll just call it "theQueryName". The real 
name will be long and may resemble something like this: 

triItem__triMoveRequestLineItem__triMoveRequestLi
neItem_BulkPrint 

The URL takes exactly 4 parameters: 

1. source (which is always "bulk") 

2. version (which is always "2") 

3. queryName (equal to "theQueryName") 

4. then one of the following: 

a. docId (which is the docId of the report you want to 
bulk print) 

  OR 

b. reportPath (which is the path of the report you want 
to bulk print) 

Your final URL will look something like the following: 

/html/en/default/common/RepBuilder.jsp?source=bul
k&version=2&queryName=theQueryName&docId=1234 

 OR 

/html/en/default/common/RepBuilder.jsp?source=bul
k&version=2&queryName=theQueryName&reportPath=\RO
OT\Report1.rpt 

Depending on which of the optional parameters you use. 
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Topic Tip 

For example: 

/html/en/default/common/RepBuilder.jsp?source=bul
k&version=2&queryName=triTask__triInspectionTask_
_triInspectionTask_Selected_Tasks_Bulk_Print&docI
d=1488586 

7. Now that you have your URL, you will need to place it anywhere 
in the system that can take a custom URL, or you can simply cut 
and paste the URL into the address bar of your browser, as long 
as you still have a valid session open. 

For example, you can place a link in a smart section and put the 
above URL as the hyperlink. If you decide to do this, and you 
chose to use the File Path as your last parameter, you will need 
to escape or URLEncode the path backslashes. Otherwise it will 
not work because the hyperlink is passed using JavaScript and 
the non-encoded characters will break the JavaScript code. 

8. Click the link you created in the previous step. The system runs 
the query you set up in step 2 to return only the business object 
Record Ids. It uses the data from all of those records in the 
Crystal report identified in step 4. In Crystal, you may want to 
modify the report to group and/or page the data by a field such 
as triRecordIdSY, thus giving you a bulk printing solution. 

Cleanup After you finish creating a report, delete the files from the 
XML_Data_Source\Forms or XML_Data_Source\Queries folder. 
When you do so, the next time you create a report you only will be 
working with the XML files for that report. 

Could not get metadata for 
report Error 

System cannot find the file 
specified Error 

An error like this indicates either the Report Directory or Temp 
Directory is invalid. In most situations, the invalid path is left behind 
by a previous version of RAS server. 

Make sure the paths are valid. In order to work with IBM TRIRIGA, the 
Crystal RAS server needs each of these values to be populated with a 
valid directory path. The IBM TRIRIGA Application Platform does not 
require any specific structure for these directories, and they can be 
the same path. 

Crystal Selections Can be used in the same report as IBM TRIRIGA filters. 

Whenever possible use IBM TRIRIGA filters on the IBM TRIRIGA query 
to minimize the size of the XML file. 

Use Crystal selections to further limit records after the join. Use 
Crystal parameters to further select data. 
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Topic Tip 

Currency To ensure that null or blank currency values display as $0.00 when 
generating reports, take the following steps: 

• Open the report in Crystal. 

• Select File > Report Options... 

• Select the check box labeled "Convert Database NULL Values to 
Default". 

• Select the check box labeled "Convert Other NULL Values to 
Default". 

• Click OK. 

• Save the report. 

Filters When adding a filter to a report: 

• IBM TRIRIGA filters – Use IBM TRIRIGA filters if possible. IBM 
TRIRIGA filters select the data before it goes to the XML file. The 
smaller the XML file, the better. 

o Adding IBM TRIRIGA filters does not affect the Crystal report 
code. 

o You do not have to check in / check out of the Document 
Manager. 

• Crystal filters – Use Record Select, Group Select, or Parameters. 

IndexOutOfBoundsException An error like this is a JRC-specific issue. The exception occurs 
because the parameter used by the Command table is being 
renamed. This technique works for reports run in a RAS server; 
however, JRC throws an IndexOutOfBoundsException. 

The workaround is to make sure the parameter used by the 
Command table matches the one defined in Parameter Fields, as 
illustrated below: 

Java Reporting Component Java Reporting Component (JRC) is a self-contained set of reporting 
libraries that run inside an IBM TRIRIGA application server. When a 
report runs using JRC, the report executes and renders without 
making calls to the report server. Because of the JRC architecture, it 
executes and renders reports faster than the traditional report 
server. JRC is best suited for smaller data sets; run larger data sets 
on a dedicated report server. 

By default, all form reports run through JRC. 

If a particular report should be run via the report server instead, the 
report can be configured to use the report server by putting 
::DISABLE_CRYSTAL_EMBEDDED_ENGINE:: in the Comments 
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Topic Tip 

section in the SAP Crystal Report property. 

Maximum Processing Limit When you run a Crystal report that returns a lot of data, you may get 
an error on the page stating that the Crystal server has reached its 
maximum processing limit. By default, Crystal installs with the 
maximum at 20000. You can change this value in the properties of 
your Crystal server. Modify the Number of database records to read 
when previewing or refreshing a report property either to something 
larger or to -1 for unlimited. 

Memory Management No single Crystal report can consume more than a specified amount 
of the server’s available memory. This specified amount is 
configured in the CRYSTAL_MEMORY_USAGE_LIMIT property in 
TRIRIGACRYSTAL.properties. If, while running a Crystal report, 
the platform detects that the configured threshold has been 
reached, it throws an exception. In the case of an interactive Crystal 
report, a message stating this information displays to the user. The 
message says, “Error Occurred. There are not enough resources 
available to run the report at this time. – [MID – 32343]”, where the 
MID refers to the message ID of a log entry in the server log. The 
entry in the log file has additional information about the amount of 
memory available at the beginning of the query execution and how 
much was consumed before the query threw the error. 

Multi-Query Joins For query reports, a query is created for each table. Note that a 
query can contain data from many business objects, similar to doing 
a join prior to the Crystal join. The fewer the queries, the more 
efficient the report. The queries must have fields that can be joined 
in Crystal. 

The standard join types supported by Crystal are: 

• Inner Join – Displays only those records from both tables that 
have matching values for the linked fields. Inner Joins are used 
frequently when there is a one-to-one relationship between the 
left and right tables. Be careful when using Inner Joins on multi-
record reports since data from the tables will be omitted if there 
are no matching values in the linked fields. 

• Left Outer Join – Displays all records from the left table and only 
those records from the right table that have matching values for 
the linked fields. Left Outer Joins are used commonly for multi-
record reports when joining multiple tables. 

• Right Outer Join – Displays all records from the right table and 
only those records from the left table that have matching values 
for the linked fields. Right Outer Join is not always available. 

• Full Outer Join – Displays all data from both tables, but joins the 
data on the same row if there are matching values for the linked 
fields. Full Outer Join is not always available. 
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Streaming The data from non-form reports that do not contain sub-reports 
stream from the IBM TRIRIGA server to the Crystal RAS server.  

To Display Logos To display logos in Crystal, you must have direct access to the 
database. You must connect with access to the data schema. 

1. Select Database Expert on the SAP Crystal Report. 

2. Create a new ODBC connection with TririgaIBS as the 
DSN. Supply the User ID and Password. Select Add Command. 

3. In the parameter list, create a new parameter called 
$$COMPANYLOGO$$ as a numeric field. The default value 
should be blank. 

4. In the SQL section, enter the query below. 

Select content from dm_content where 
content_id = 

With your cursor immediately to the right of the = in the SQL 
statement, double-click the $$COMPANYLOGO$$ parameter 
to insert the parameter into the SQL statement. The 
resulting statement should read:  

Select content from dm_content where 
content_id = {?$$COMPANYLOGO$$}. 

5. Exit the Database Expert. 

6. From the Field Explorer, Expand Database Fields > 
Command. Select the Content command that holds the logo 
and insert it into the Page Header section. 

7. Right-click the Content field in the page header and select 
Format Graphic. 

8. Click the Picture tab and change the Scaling Width to 183%, 
and Height to 48%. 

9. When this report is uploaded into the Document Manager, 
the logo should be visible. 

The logo will not appear until the report is run from within IBM 
TRIRIGA. 
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ADO XML v1 
The ADO XML v1 action is for legacy reports created prior to TRIRIGA Application Platform 2.7.0. Use 
the ADO XML v2 action whenever possible. 

ADO XML v1 does not support a query that contains multiple associated business objects. 

The field name format for ADO XML v1 is SectionName_FieldName. For example, 
RecordInformation_triNameTX, triRealEstateLeaseContract_triNameTX. 

With ADO XML v1, the ADO XML generated for a query section in a form for a form report takes all 
fields from the primary business object. 

ADO XML v2 Formats 

ADO XML v2 Field Name Format 

ADO XML v2 uses the following format to identify fields: 

ModuleName_BusinessObjectName_SectionName_FieldName[_Index] 

where: 

Element Description 

ModuleName The module of the business object for the field. 

BusinessObjectName The business object for the field. 

SectionName The section for the field. 

The platform does not include “General” section names (e.g., 
General, RecordInformation). If omitted, you will still see the _. For 
example, triProject_triProject__triNameTX. 

FieldName The field name. 

Index In cases where there is a duplicate field name, for example from a 
multi-business object source, the platform adds Index to ensure 
field uniqueness in the ADO XML. 

Index is an incremental positive integer. It is used first with the 
first duplicate occurrence. For example, the first time the 
ModuleName…FieldName occurs, there is no Index. The second 
and subsequent times the same ModuleName…FieldName occurs, 
the platform adds _2, _3, and so on. 
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 Note – If you change the sequence of fields with duplicate names in the Columns tab, your 
Crystal report will not be correct. If you change the definition in the Report Manager in 
any way, you also must change the Crystal report. 

If the ModuleName_BusinessObjectName_SectionName_FieldName[_Index] includes a special 
character, the platform uses the following encoding/decoding characters: 

Special Character Platform Changes To 

: (colon) :| (colon-pipe) 

_ (underscore) :: (colon-colon) 

For example, if module = triPeople, business object = triPeople, section = ReportsTo, and field 
= triFirst_Name, the field name is encoded to 
triPeople_triPeople_ReportsTo_triFirst::Name. 

ADO XML v2 Data Source Encoding 

ADO XML v2 file names are prefixed with a data source tag. The data source tag identifies the data 
source type that the XML file contains, and it is in the format [v2<datasourcetag>]. 

Form reports are used in a record’s Reports tab or when a user clicks the Form action on a record. For 
form reports, the ADO XML v2 output is made up of the organization, project, top-level business 
object, and the business object’s sections’ ADO XML files. The following table lists the data sources for 
a form report: 

Prefix Description 

[v2SYS] 
The ADO XML output for Organization and Project. 

These files are of the form [v2SYS]+BusinessObjectName 

For example, [v2SYS]Organization 

[v2BO] 
The ADO XML output for the top-level business object. 

These files are of the form 
[v2BO]+ModuleName_BusinessObjectName 

For example, [v2BO]triPeople_triPeople 

[v2SS] 
The ADO XML output for smart sections. 

These files are of the form 
[v2SS]+ModuleName_BusinessObjectName_SmartSectionNam
e 

For example, [v2SS]triPeople_triPeople_triCalendar 
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Prefix Description 

[v2QS] 
The ADO XML output for form query sections. 

These files are of the form 
[v2QS]+ModuleName_BusinessObjectName_FormSectionName 

For example, [v2QS]triPeople_triPeople_triPhone 

[v2CS] 
The ADO XML output for smart sections that reference a Link 
business object. 

These files are of the form 
[v2CS]+ModuleName_BusinessObjectName_SectionName 

For example, [v2CS]triPeople_triPeople_triTestSection 

Query reports may contain data from any number of top-level records. They also may contain multiple 
levels of detail that are accessible through associated business objects and records. Most often query 
reports are used to display multi-record reports. The following table lists the data sources for a query 
report: 

Prefix Description 

[v2QRY] 
The ADO XML output for query report. 

These files are of the form 
[v2QRY]+ModuleName_BusinessObjectName_QueryName 

For example, [v2QRY]triPeople_triPeople_triPeople---+-
-Reports-To---+--Manager 

ADO XML v2 Table Name Format 

If the ADO XML v2 table name includes a special character, the platform uses the following 
encoding/decoding characters: 

Special Character Platform Changes To 

“ ” (space) -- (hyphen-hyphen) 

- (hyphen) -| (hyphen-pipe) 

_ (underscore) -~ (hyphen-tilde) 
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Notices 

This information was developed for products and services offered in the U.S.A. 

IBM may not offer the products, services, or features discussed in this document in other countries. 
Consult your local IBM representative for information on the products and services currently available in 
your area. Any reference to an IBM product, program, or service is not intended to state or imply that only 
that IBM product, program, or service may be used. Any functionally equivalent product, program, or 
service that does not infringe any IBM intellectual property right may be used instead. However, it is the 
user's responsibility to evaluate and verify the operation of any non-IBM product, program, or service. 

IBM may have patents or pending patent applications covering subject matter described in this document. 
The furnishing of this document does not grant you any license to these patents. You can send license 
inquiries, in writing, to: 

IBM Director of Licensing 
IBM Corporation 
North Castle Drive 
Armonk, NY 10504-1785 
U.S.A. 

For license inquiries regarding double-byte character set (DBCS) information, contact the IBM Intellectual 
Property Department in your country or send inquiries, in writing, to: 

Intellectual Property Licensing 
Legal and Intellectual Property Law 
IBM Japan, Ltd. 
19-21, Nihonbashi-Hakozakicho, Chuo-ku 
Tokyo 103-8510, Japan 

The following paragraph does not apply to the United Kingdom or any other country where such provisions 
are inconsistent with local law: 

INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS PUBLICATION "AS IS" WITHOUT 
WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED 
WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. Some 
states do not allow disclaimer of express or implied warranties in certain transactions, therefore, this 
statement may not apply to you.  

This information could include technical inaccuracies or typographical errors. Changes are periodically 
made to the information herein; these changes will be incorporated in new editions of the publication. IBM 
may make improvements and/or changes in the product(s) and/or the program(s) described in this 
publication at any time without notice. 

Any references in this information to non-IBM Web sites are provided for convenience only and do not in 
any manner serve as an endorsement of those Web sites. The materials at those Web sites are not part of 
the materials for this IBM product and use of those Web sites is at your own risk. 
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IBM may use or distribute any of the information you supply in any way it believes appropriate without 
incurring any obligation to you. 

Licensees of this program who wish to have information about it for the purpose of enabling: (i) the 
exchange of information between independently created programs and other programs (including this one) 
and (ii) the mutual use of the information which has been exchanged, should contact:  

IBM Corporation 
2Z4A/101 
11400 Burnet Road 
Austin, TX 78758 
U.S.A. 

Such information may be available, subject to appropriate terms and conditions, including in some cases, 
payment of a fee.  

The licensed program described in this document and all licensed material available for it are provided by 
IBM under terms of the IBM Customer Agreement, IBM International Program License Agreement or any 
equivalent agreement between us. 

Information concerning non-IBM products was obtained from the suppliers of those products, their 
published announcements or other publicly available sources. IBM has not tested those products and 
cannot confirm the accuracy of performance, compatibility or any other claims related to non-IBM 
products. Questions on the capabilities of non-IBM products should be addressed to the suppliers of those 
products. 

All statements regarding IBM's future direction or intent are subject to change or withdrawal without 
notice, and represent goals and objectives only. 

This information contains examples of data and reports used in daily business operations. To illustrate 
them as completely as possible, the examples include the names of individuals, companies, brands, and 
products. All of these names are fictitious and any similarity to the names and addresses used by an actual 
business enterprise is entirely coincidental. 

Privacy Policy Considerations 
IBM Software products, including software as service solutions, (“Software Offerings”) may use cookies or 
other technologies to collect product usage information, to help improve the end user experience, to 
tailor interactions with the end user or for other purposes. In many cases no personally identifiable 
information is collected by the Software Offerings. Some of our Software Offerings can help enable you to 
collect personally identifiable information. If this Software Offering uses cookies to collect personally 
identifiable information, specific information about this offering’s use of cookies is set forth below. 

This Software Offering does not use cookies or other technologies to collect personally identifiable 
information. 

If the configurations deployed for this Software Offering provide you as customer the ability to collect 
personally identifiable information from end users via cookies and other technologies, you should seek 
your own legal advice about any laws applicable to such data collection, including any requirements for 
notice and consent. 

For more information about the use of various technologies, including cookies, for these purposes, see 
IBM’s Privacy Policy at www.ibm.com/privacy and IBM's Online Privacy Statement at 

http://www.ibm.com/privacy
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www.ibm.com/privacy/details in the section entitled “Cookies, Web Beacons and Other Technologies” and 
the "IBM Software Products and Software-as-a-Service Privacy Statement" at 
www.ibm.com/software/info/product-privacy/. 

Trademarks 
IBM, the IBM logo, ibm.com, and TRIRIGA are trademarks or registered trademarks of International Business 
Machines Corp., registered in many jurisdictions worldwide.  

Adobe, the Adobe logo, PostScript, and the PostScript logo are either registered trademarks or trademarks 
of Adobe Systems Incorporated in the United States, and/or other countries. 

Java and all Java-based trademarks and logos are trademarks or registered trademarks of Oracle and/or its 
affiliates. 

Linux is a registered trademark of Linus Torvalds in the United States, other countries, or both. 

Microsoft, Windows, Windows NT, and the Windows logo are trademarks of Microsoft Corporation in the 
United States, other countries, or both.  

UNIX is a registered trademark of The Open Group in the United States and other countries. 

Other product and service names might be trademarks of IBM or other companies. A current list of IBM 
trademarks is available on the Web at “Copyright and trademark information” at 
www.ibm.com/legal/copytrade.shtml. 

http://www.ibm.com/privacy/details
http://www.ibm.com/software/info/product-privacy/
http://www.ibm.com/legal/copytrade.shtml
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